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Introduction 
A PivotTable, also called PivotTable Report, is a summary table which uses two dimensional 
data to create a three-dimensional table based on multiple conditions that have intersecting 
points.  With just a few short steps, PivotTable can summarize large amounts of information in a 
small amount of space. The advantage of the PivotTable is its flexibility to view the details that 
make up the total number and its ease in performing numerous calculations without typing a 
formula. This handout is designed to teach how to create and revise a PivotTable report and a 
PivotChart Report as well as to publish a PivotTable in HTML Format. 

Scenario 
Many companies and organizations use Excel to deal with numeric data and analyze it from a 
different prospective. A bank report is one of the examples which show how a dataset is 
analyzed based on multiple conditions. For instance, it is used to show the account balance, the 
account average balance, the number of accounts, and the open date of the accounts in each 
branch.  Also, it seeks to compare the data between branches. In addition, the use of different 
kinds of graphs provided in Excel enhances the analysis of the data as well as its appearance. 
Therefore, this handout will demonstrate how the user can customize a bank report appropriate to 
the purpose, by employing the PivotTable or PivotChart wizard. Furthermore, it will help the 
user to understand how to perform numerous calculations with ease in the PivotTable and 
PivotChart.  

The dataset of Part two includes several data fields such as bank branch, account type, customer 
type, and open date; which demonstrate the relevant data for a bank report. The bank branches 
include Central, Northwest, and Westside. There are three types of bank accounts which include 
the CD (Certificate of Deposit), Checking, and Saving Accounts. The dataset categorizes the 
customers into four types, such as Personal, Personal VIP, Corporate, and Corporate VIP 
depending on their current balance, average balance, and other factors affecting their credit for 
the past five years. In this dataset, the average balance and other factors will not be displayed for 
the users to simplify creating a PivotTable report. Also, the dataset shows only the open dates of 
accounts from 2001 to 2005, but the date items can be grouped by months, quarters, and years in 
the PivotTable and PivotChart Reports. 

Creating a PivotTable 
A PivotTable Report is created using the PivotChart Wizard which walks the user through the 
step-by-step process. 
 



CREATING A PIVOTTABLE REPORT 
To open the data file: 

1. Select the Start menu ► 
Microsoft Excel. 

2. Click the Open button  on the 
Standard toolbar. The Open 
dialog box appears. 

3. In the Open dialog box, select the 
drive where the data file is stored 
in the Look in: list box.  Double-
click the file named 
“PivotTable.xls.” 

 
Figure 1 - PivotTable & Chart Wizard (Step One of Three) 

To create a PivotTable: 
1. Place the cursor anywhere in the range of the database. 
2. From the Data menu, select PivotTable and PivotChart Report….. The PivotTable and 

PivotChart Wizard – Step 1 of 3 dialog box opens (see Figure 1).  
3. Select the  Microsoft Office Excel list or database option button, under Where is the 

data that you want to analyze?  
4. Select  PivotTable under 

What kind of report do you 
want to create?  

5. Click the Next button. The 
PivotTable and PivotChart 
Wizard – Step 2 of 3 dialog box 
opens (see Figure 2). 

6. The range of data is 
automatically given as; 
$A$1:$E$200. It resulted from 
the position of the cursor in the 
worksheet before staring the 
PivotTable and PivotChart 
Wizard. Otherwise, click on the 
edit box and select a range of 
data to use from $A$1:$E$200.  

7. Select the Next button. The 
PivotTable and PivotChart 
Wizard – Step 3 of 3 dialog box 
opens (see Figure 3). 

Figure 2 - Step Two of Three 

Figure 3 - Step Three of Three 

8. Select  New worksheet under Where do you 
want to put the PivotTable report?  

9. Click the Finish button. “Sheet1” is 
automatically created (see Figure 4). 
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Figure 4 - Drag Data Items 

Adding PivotTable Report Fields 
When the fields from the selected data appear on the right side of the screen, each field needs to 
be added into the PivotTable layout.  

The following describes the four areas that are available for adding a field (see Figure 5): 
1. Page: Creates a drop-down menu above the table to analyze a specific item from the 

field, such as a selected branch. 
2. Row: Applies a vertical format to the table, summarizing the data from top down. The 

row drop area lists each item in the field down the left side of the PivotTable. 
3. Column: Applies a horizontal format to the table, summarizing the data from left to 

right. The column drop area lists each item in the field across the top of the PivotTable. 
4. Data: The data drop area is the summary of the numbers. This area adds, counts, or 

creates other analytical functions against the data dropped here. 

 
Figure 5 - Field Placement Areas 

To add fields into the PivotTable layout under the PivotTable Field List dialog box:  
1. Click the Branch field. Drag and drop it into the Page drop area.  
2. Click the Account Type field. Drag and drop it into the Row drop area. 
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3. Click the Customer Type field. Drag and drop it into the Column drop area. 
4. Click the Balance field. Drag and drop it into the Data drop area (see Figure 6). 

 
Figure 6 - PivotTable Layout 

5. Double click on the worksheet tab “Sheet1” and rename it “PivotTable”. 

Selecting a Page Field Item 
When each field is dropped in the drop zone, a user can customize a summary report by selecting 
one of the items in the pages field dropdown box. 

To select a page field item: 
1. When the field data is dropped in 

the page drop area, the PivotTable 
Report displays a summary of all 
the data because (All) is selected by 
default (see Figure 7). 

2. To change a page field item, click 
the drop-down box and select 
Northwest (see Figure 8). 

3. Notice the PivotTable Report 
displays the summary of the 
Northwest branch data only (see 
Figure 9). 

 
Figure 7 - Selecting a Page Field Item 

 
Figure 8 - Changing a Page Field Item 

 
Figure 9 - Northwest Branch Displayed 

Revising a PivotTable Report 
Once a PivotTable or PivotChart is created, the user can restructure the PivotTable or PivotChart 
by dragging and dropping fields, by using the options on the menus, or by using the PivotTable 
toolbar. Formatting options can also be used to change the look or structure of the PivotTable. 
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REFRESHING A PIVOTTABLE REPORT   
After a PivotTable is created, if some data in the original worksheet has changed, the PivotTable 
must be refreshed to automatically update the contents of the table. 

To refresh a PivotTable Report: 
1. Click on worksheet “Data.” 
2. Click cell D3, as a Checking product opened in the Northwest branch. 
3. Change the value of cell D3 to 1,000,000.  
4. Click worksheet “PivotTable.”  
5. Display the PivotTable toolbar.  
6. Click on the  icon on the toolbar (see 

Figure 10). 
7. Notice that the PivotTable automatically 

refreshes the data.  Figure 10 - Refresh Button 

CHANGING THE SUMMARY FUNCTION   
By default, PivotTable uses the sum function to summarize the data, but the user can change the 
summary method of a PivotTable or PivotChart data by using different summary functions. 

To change the summary function: 
1. In the PivotTable, click cell A3 in the 

data area. 
2. On the PivotTable Toolbar, click the 

Field Settings   icon. The PivotTable 
Field dialog box appears (see Figure 11). 
Double-clicking cell A3 also brings up 
the PivotTable Field dialog box. 

3. In the Summarize by: box, click the 
Count function to count the number of 
occurrences of each balance type. 

4. Click OK. 
5. Notice that the PivotTable displays the 

count of balance (see Figure 12). 

 
Figure 11 - Count Summary Function 

 
NOTE: Another way of change the summary function is by double-clicking cell A3. 

 
Figure 12 - Count Summary of Balance Function 
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Adding New Fields to a PivotTable Report 
New Fields can be added to the PivotTable to view other aspects of the bank balances. 

To add a new field:  
1. Open the worksheet “pivot_rev.”  
2. From the PivotTable Field List dialog box, click the Open Date field and drag it to the 

left of the Account type area (see Figure 14). 

 
Figure 13 - Adding a New Field Figure 14 - Open Date Field Added to PivotTable 

 
NOTE: Different field items can only be places in certain areas. See table for the list and description. 

Table 1- PivotTable Field List Icons 
Icon Description of Icon 

 Can only be used in the Row, Column, and Range field areas. 

 Can only be used in the Data Range of the PivotTable. 

 Can be used in any field area in the PivotTable. 

Changing the Order of Data Fields    
To change the order of data fields:    

1. Place the cursor in cell A4 and right-
click.  

2. Point to Order on the shortcut menu.  
3. Select the Move Right option. 
4. Notice that the Open Date field is 

moved to the right of the Account 
Type field. Figure 15 - Changing the Oder of Data Fields 

 
NOTE: As an alternative way, point the cursor on a data field cell. The pointer becomes a 4 headed 
arrow. Drag the data field to the desired position. 

WORKING WITH DATES  
PivotTable enables numeric items, dates and times, and selected items to be grouped by a desired 
range. This section explains grouping by dates, but grouping other items can be applied in the 
same manner. 
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To group dates: 
1. Place the mouse cursor in cell A4.  
2. Right-click and select the Group…option 

under Group and show detail option. The 
Grouping dialog box appears (see Figure 16). 

3. By default, the two dates, Starting at: and 
Ending at:, are automatically selected based 
on the field data (see Figure 17). 

4. In the By box, select Months, Quarters, 
Years to group the dates in the data field area 
by month, quarter, and year (see Figure 18). 

5. Notice the data fields are grouped by years, 
quarters, and months in separate columns. 

Figure 16 - Grouping By Dates 

 
Figure 17 - Grouping Dialog Box  

Figure 18 - Grouped by Year 

Showing and Hiding Detail 
In the PivotTable, users can show or hide details of the fields. 

To hide details of the Year field:  
1. Click the field’s heading, cell A4.  
2. Right-click and select Group and show 

Detail. 
3. Select the Hide detail option (see 

Figure 19).     
Figure 19 - Hiding Details 

To show hidden details of the field: 
1. Click the field’s heading, cell A4. 
2. Right-click and select Group and show 

Detail  
3. Select the Show detail option (see 

Figure 20).  
Figure 20 - Show Hidden Details 
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Hiding/Displaying PivotTable Fields   
PivotTables enable a particular data field to be hidden and redisplayed. 

To hide the Open Date field in the 
PivotTable report: 

1. Double click cell C4. The 
PivotTable Field dialog box 
appears.  

2. Click on the Hide option (see 
Figure 21). 

3. Notice that the Open Date field is 
hidden in the PivotTable report. 

 
Figure 21 - Hiding PivotTable Fields 

To redisplay the hidden field in the 
PivotTable report: 

1. On the PivotTable toolbar, click 
on the Show/Hide Field List  
icon. The PivotTable field list 
dialog box appears (see Figure 
22). 

2. Double click the Open Date field. 
3. Notice that the Open Date field 

now appears in the PivotTable 
report. 

 
Figure 22 - Redisplaying the Hidden Field 

 
 
NOTE: As an alternative way, click on 

Show  Detail   icon on the 
PivotTable toolbar. The Show Detail 
dialog box appears. Then, double click 
the Open Date field. 

 

APPLYING AUTOFORMATS 
In Excel, it is possible to manipulate and format a PivotTable, such as changing the font, point 
size, colors, etc. This section shows how Excel automatically applies a preset AutoFormat to a 
new PivotTable. 
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To apply AutoFormat to a PivotTable: 
1. Place the cursor anywhere in the 

PivotTable report. 
2. Click the Format Report  

button on the PivotTable 
toolbar.  

3. Select one of the AutoFormats 
from the list (see Figure 23).  

4. Click OK. 

Figure 23 – AutoFormat Dialog Box 

Creating a PivotChart Report   
A PivotChart Report provides interactive analysis of data, like a PivotTable Report. The display 
view of the data can easily be changed to see different level of details, and the organization of 
the chart layout can be changed by dragging fields and by showing or hiding items in fields. 
There are several different types of data sources that can be used such as the list or table taken 
from an Excel list or range, an external database, or another PivotTable Report.  

CREATING A PIVOTCHART REPORT 
To create a PivotChart Report using an existing PivotTable:  

1. Open the file “PivotChart.xls” from the student data directory.  
2. Select the worksheet “PTable”. 
3. Place the cursor in the PivotTable area.  
4. Click on the Chart Wizard  icon on the Standard toolbar.  
5. A PivotChart is created on a new worksheet, “Chart1” (see Figure 24). 

 
Figure 24 - PivotChart Report 
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Changing a Chart Type 
To change the chart type: 

1. Select the Chart menu ► Chart 
Type…option. The Chart Type dialog 
box appears.  

2. In Chart type:, select the Bar  
option (see Figure 25).  

3. In Chart sub-type:, select the clustered 
bar  option (the first column, the 
second row).  

4. Click OK. 
 
NOTE: To preview the chart click the Press 
and Hold to View Sample button. 

Figure 25 - Changing Chart Type 

Dragging Fields from the PivotTable Field List 
A PivotChart offers the power of PivotTables and normal charts combined in one interactive 
medium. As the fields are dragged to new locations on the chart, Excel will pivot the chart to 
correspond to the new field location.  

To drag fields from the PivotTable field list: 
1. Select the Pivot table to display the PivotTable toolbar.  
2. Click on the Show Field list  button.  
3. Drag the Account Type field to the area next to the Years field at the bottom of the chart 

area (see Figure 26). 

 
Figure 26 - Dragging Fields to PivotChart Report 
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FORMATTING A PIVOTCHART  
Formatting changes the appearance of the chart. The formatting options available depend on the 
selected object. For example, if the chart area is selected, Excel allows the patterns, fonts, and 
chart area properties to be changed.  The user can also use the buttons on the Formatting toolbar 
to format text, add values, data points, and data series, as well as fill colors and patterns. 

To format a chart title using the formatting button on 
the Chart toolbar: 

1. Open the file “PivotChart2.xls” from the 
student data drive. 

2. Click on the worksheet “Chart1” to begin 
formatting. 

3. Click on the chart title once to select it. 
4. Click on the Format Chart Title button (see 

Figure 27). The Format Chart Title dialog box 
appears. 

 
Figure 27 - Format Title Toolbar 

5. Select Font tab. Change font type, font style, 
font size, and font color as desire (see Figure 
28.) 

 
Figure 28 – Format Title (Font)  

 
6. Select Patterns tab. Change border 

style, line color, line weight and 
filled area color as desire (see Figure 
29).  

Figure 29 - Format Title (Patterns) 

7. Select Alignment tab to change text 
alignment and orientation degree 
(see Figure 30). 

Figure 30 – Format Title (Alignment) 
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Displaying Data labels  
Without labels for data, it can be difficult to determine what each item refers to. Excel allows 
data labels to be displayed in the PivotChart.  

To display data labels: 
1. Select the Chart menu ► Chart Options.  
2. Under the Data Labels tab, select the Percentage check box (see Figure 31). 

Figure 31 - Applying Data Labels 
 

Figure 32 - Displaying Data Labels 

Saving and Publishing a PivotTable in HTML Format 
Excel can save a PivotTable as an HTML document and modify HTML documents posted on an 
Internet or intranet site. The benefit of this feature is that the data fields can be manipulated, 
changed, and then printed while the document is posted. The changes cannot be saved in the 
Excel format. Changes made to the HTML document are saved in the HTML format. 

SAVING AND PUBLISHING A PIVOTTABLE 

To save a PivotTable as a 
webpage: 

1. Open the data file 
“pivottable_html.xls” 
from the student data 
drive. 

2. Click on the worksheet 
“PivotTable.”  

3. Select the File menu, ► 
Save as Web Page.  

4. Specify the location of the 
file to save (e.g., 
Desktop). 

5. Select the   
radio button (see Figure 
33). Figure 33 - Saving a PivotTable 
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NOTE: If a range is selected (PivotTable) before using the Save as Web Page command in the File 
menu, the Selection option will reflect the selected range instead of the entire sheet.  

6. Check Add interactivity  option. The Add interactivity feature 
enables the user to create spreadsheet functionality (formulas and so on) or PivotTable 
functionality. 

7. In the File name field, type [PivotTable]. 
8. Click on the Change Title… button.  
9. Type [Bank Report] in the Change Title box 
10. Click OK. 
11. Click on the Publish button. 
12. In the Publish As Web Page dialog box, select the sheet from the Choose list. Then select 

the entire sheet or just the PivotTable range. For example, under the Item to publish, 
select Items on PivotTable and then PivotTable (PivotTable2($A$1:$E$8) (see Figure 
34). 

13. Click on the Publish button. 

 
Figure 34 - Publish as a Webpage 

OPENING A PIVOTTABLE IN THE WEB BROWSER 
Once a PivotTable is saved as a web page, users can view the PivotTable in a web browser, such 
as Internet Explorer and Netscape Navigator.  

To open a PivotTable in the web browser: 
1. Launch Internet Explorer by clicking on the  icon.  
2. In the File menu, select the Open… option to find the location of the PivotTable file. The 

Open dialog box appears.  
3. Click on the Browse button (see Figure 35). 
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Figure 35 - Open the PivotTable in Web Browser 

4. Click Desktop in the Look in: drop-down list and select the file, “PivotTable.” 
5. Click the Open button. 
6. In the Open dialog box,  OK button. The PivotTable appears in the web browser (see 

Figure 36). 

 

 
Figure 36 – Viewing the PivotTable in Web Browser 

SORTING THE DATA RECORDS 
Excel enables users to arrange a list of records alphabetically or numerically according to the 
contents of the column or row. Unless otherwise specified, Excel automatically sorts from top to 
bottom. The data can be sorted in ascending and descending order. Ascending order sorts a list 
from the lowest to highest value. Descending order sorts a list from the highest to lowest value. 

To sort in a descending order: 
1. Place the cursor in the Account Type cell; notice that the column field zone is 

highlighted. 
2. Click on the Sort Descending button  on the PivotTable toolbar. 

To sort in an ascending order: 
1. Place a cursor in the Account Type cell; notice that the column field zone is 

highlighted.  
2. Click on the Sort Ascending button  on the PivotTable toolbar. 
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Showing and Hiding Details 
Excel enables users to show and hide details of the fields in the PivotTable.    

To show details:  
1. Place the cursor in the Account Type field; notice that the column field zone is 

highlighted. 
2. Click on the Show Details icon  on the PivotTable toolbar to show details of all 

accounts.  

 
NOTE: To show details of the specific account, click on the  button to the right of the account type.  

To hide details: 
1. Place the cursor in the Account Type field; notice that the column field zone is 

highlighted. 
2. Click on the Hide Details icon  on the PivotTable toolbar to hide details of all 

accounts.  

 
NOTE: To hide details of the specific account, click on the  button to the right of the account type. 

 
Figure 37 - Showing and Hiding Details 

 
NOTE: The dropdown list can be used to select and deselect items. For example, to display all the 
items of the Account Type, select the  check box.  

Expanding and Collapsing Selections with Interactivity 
Excel enables users to expand and collapse the selected item with interactivity as long as the 
selection is associated with source data. For example, if the users add the Open date field which 
is grouped by years, months, and dates in the PivotTable area, they can keep expanding the data 
by more specified dates. 

To expand the selection:  
1. Click on the PivotTable Field List icon  on the PivotTable toolbar  (see Figure 38).  
2. Click on the  icon in the Open Date by Month to display the details.  
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3. Drag the Open Date by Month field and drop it to the right of the Account type field.  
4. Place the cursor on the Years field. 
5. Click on the Expand icon  on the PivotTable toolbar. Notice that the Quarters field 

is displayed in the PivotTable.  
6. Place the cursor on the Quarters field and click on the Expand icon  on the 

PivotTable toolbar. 
7. To keep expanding the data, repeat step 5 until the Days field is displayed. 

 
Figure 38 - PivotTable Field List 

Figure 39 - Expanding the Selection 

To collapse the selection: 
1. Place the cursor on the Years 

field (see Figure 40). 
2. Click on the Collapse icon 

 on the PivotTable 
toolbar. Notice that all other 
fields under the Years field 
are hidden in the PivotTable.  

 

Figure 40 - Collapsing the Selection 

 

 
NOTE: Collapsing does not remove the field itself. To remove the unnecessary fields in the 
PivotTable, the user can right-click over the field category and select the Remove Field option. 

FORMATTING A PIVOTTABLE SAVED AS A WEBPAGE 
Even if the PivotTable is opened in the web browser, the user can format the PivotTable to 
enhance its appearance. For example, the user can change the font type (the overall appearance), 
the font size (the amount of space the text occupies on the printed page) and the font style 
(bolding, italics, etc.). The user can also use the Fill Color button to add shading to a cell 
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background. Shading allows making items distinct from the rest of the worksheet.  This section 
demonstrates how to format text and cells. 

To format text and cells: 
1. Place the cursor in the Account Type field.  
2. Click on the Commands and Options   

button on the PivotTable toolbar. The 
Commands and Option dialog box appears 
(see Figure 41).  

3. Select Format tab. 
4. Under Text Format, click on the  button 

to apply the bold effect, click on the  
button to apply the italics effect, and click 
on the drop down arrow of the   button 
to change the font color. 

5. Change the font type and size as desired by 
selecting from the drop down list of Font: 
text box.  

6. Under Cell format, choose a desired color 
to add shading to a cell background. Notice 
that the new format is applied to the 
Account Type field in the PivotTable. 

Figure 41- Commands and Options Dialog Box 
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